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Use of a shielded cable with the ferrite core(s) provided with the scanner is necessary to comply with the technical
requirements of the EMC Directive.

Warning
When you use this product, you should pay attention to the following legal issues:
• Scanning of certain documents, such as bank notes (bank bills), government bonds and public

certificates, may be prohibited by law and may result in criminal and/or civil liability.
• You may be required under law to obtain authorization from a person possessing copyrights or other

legal rights to the item being scanned.
If you are uncertain of the legality of scanning any particular item, you should consult your legal
adviser in advance.

• CanoScan and ScanGear are trademarks of Canon Inc.
• Adobe® and Acrobat® are trademarks of Adobe Systems Incorporated.
• Macintosh, Power Macintosh and Mac OS are trademarks of Apple Computer, Inc., registered in the U.S. and other

countries.
• iMac is a trademark of Apple Computer, Inc.
• Microsoft and Windows are registered trademarks of Microsoft Corporation in the U.S. and other countries.
• OmniPage Pro and OmniPage SE are trademarks of ScanSoft, Inc.
• Other names and products not mentioned above may be trademarks or registered trademarks of their respective

companies.

Copyright © 2001 Canon Inc. All rights reserved.
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Handling and Care of the Scanner
This section describes the general precautions for using the scanner. Please be sure to read each
section for safe handling and operation.

 Safety Precautions .................................................................................... 5

Setup and Operating Conditions................................................................... 7

Before Transporting the Scanner .................................................................. 8

Care and Maintenance ................................................................................... 9
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 Safety Precautions

Please read and take note of the following precautions before using the equipment.

WARNING
Indicates a warning concerning operations that may lead to death or injury to
persons if not performed correctly. In order to use the equipment safely, always pay
attention to these warnings.

CAUTION
Indicates a caution concerning operations that may lead to injury to persons or
damage to property if not performed correctly. In order to use the equipment
safely, always pay attention to these cautions.

About Locations
WARNING

• Do not place the equipment near flammable liquids such as alcohol or thinners. If
the internal electrical parts come in contact with flammable liquids, fire or electrical
shock may result.

• Do not place the following objects on top of the equipment. If the internal
electrical parts come in contact with these objects, fire or electrical shock may
result.
- metallic objects, such as necklaces
- containers with liquid, such as cups, vases and flower pots
If any of these objects or liquids enter the equipment, immediately unplug the USB
cable and contact your retailer or Canon Customer Support Help Desk.

CAUTION
• Do not place the equipment in the following areas. Fire or electrical shock may

result.
- Areas with high humidity
- Areas subject to direct sunlight
- Areas with high temperatures
- Areas near flame sources

• Do not place the equipment on shaky stands, unstable surfaces or surfaces subject
to frequent vibrations.  If the equipment falls, it may cause injuries.

• Do not place heavy objects on the equipment.  Objects may fall and cause injuries.

About the Power Supply
WARNING

• Do not damage, mutilate or modify the USB cable. Do not place heavy objects on,
pull or excessively bend the USB cable.  Damaged wires may cause fire or electrical
shock.

• Do not twist or tie the USB cable together. Fire or electrical shock may result.
• Always plug the USB cable in all the way. If it is not plugged in completely, fire or

electrical shock may result.
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General Handling Precautions
WARNING

• Do not take apart or modify the equipment. Fire or electrical shock may result from
improper handling of its components.

• If you hear unusual noises, see smoke, feel excessive heat or smell anything
unusual, immediately unplug the USB cable and contact your retailer or Canon
Customer Support Help Desk. Continued use may result in fires or electrical shock.

• Do not use flammable sprays near this equipment. Also do not spill water, liquids,
or flammable liquids on the equipment. If these fluids enter this equipment and
contact the electrical parts, fire or electrical shock may result. If anything enters the
equipment, immediately unplug the USB cable and contact your retailer or Canon
Customer Support Help Desk.

• When cleaning the equipment, always unplug the USB cable.  Otherwise, fire or
electrical shock may result.

• When cleaning the equipment, use a water-moistened cloth that is well wrung out.
Do not use flammable liquids, such as alcohol, benzene or thinners. If a flammable
liquid enters the inner electrical parts, fire or electrical shock may result.

CAUTION
• Carefully close the document cover in order not to pinch your hands.
• Do not press heavily on the document glass or the document cover.  The document

glass may break and injure you.
• Do not bump or drop a heavy book or object on the document glass.  The

document glass may break and injure you.
• When not in use for extended periods, such as long weekends, unplug the USB

cable for safety.
• When transporting the equipment, be extremely careful.  Dropping it could cause

an injury.
• Wait until the equipment has cooled before placing a cover over it.  Otherwise fire

may result.
• Do not use the supplied CD-ROM in regular CD players.  It produces excessively loud

sound that may cause hearing damage.
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Setup and Operating Conditions

• Please use in an area where the following temperature and humidity conditions can be met.
Surrounding temperature:

5 degrees - 35 degrees C (41 degrees - 95 degrees F)
Surrounding humidity:

10% - 90% RH (without condensation)

• Make certain there is plenty of clear space around the scanner.

Looking straight down on the scanner

• Set up the scanner so that the cable reaches from the scanner to the electrical outlet.

• Do not set up in areas where there is an excessive fluctuation in temperature. Also do not
move the equipment from low temperature areas to hight temperature areas.
Condensation may cause image errors. Leave the scanner enough time to gradually adapt
to the new conditions before use.

• Do not use the scanner in areas subject to direct sunlight. The humidity may rise inside the
equipment and cause damage or decrease image quality. If you have to use the scanner in
direct sunlight, make sure to use a thick curtain to block the light.

Approx. 10 cm
(4 in)

Approx. 20 cm
(8 in)

Approx. 10 cm
(4 in)

Approx. 20 cm
(8 in)

Approx.
10 cm
(4 in)

Approx. 20 cm
(8 in)

Scanner in a vertical position
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Before Transporting the Scanner

Always lock the scanning unit by pushing the lock switch toward the lock mark before moving or
transporting the scanner.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

1. Disconnect the USB cable from the computer.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

2. Confirm the position of the scanning unit.
Open the document cover, and confirm that the scanning unit is at the front of the
scanner. If it has not returned, follow the procedures below to return the scanning unit
to the home position.
1 Ensure that there are no items on the document glass (platen).
2 Turn on the computer.
3 Close the document cover, and connect the USB cable to the computer.
4 Start ScanGear CS-U and click the [Preview] button.
5 Confirm that the scanning unit has completely returned to the front of the

scanner.
6 Disconnect the USB cable.

Scanning Unit
Confirm that the scanning
unit is in this position

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

3. Lock the scanning unit by pushing the lock switch toward the
lock mark (  ).

Lock Switch

Locked

• Carrying or transporting the scanner without locking the scanning unit
may damage it. Be particularly careful to lock the scanning unit when
transporting the scanner in a vehicle.
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Care and Maintenance

Clean off the dirt and dust that adheres to the exterior, document glass and document cover of the
scanner during the course of ordinary operation using the following procedures.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

1. Disconnect the USB cable from the computer.

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

2. When cleaning the document cover or document glass, dampen
a clean, soft cloth with water and wring the cloth well. Use the
well-wrung cloth to gently remove dirt and dust. Then,
thoroughly remove any moisture or water vapor with a soft,
dry cloth. Be particularly careful to remove any traces of dirt or
liquid when wiping the document glass.
• Moisture left on the document glass or cover may damage photographs and other

documents as well as produce poor results.
• Do not dampen the connectors, ports or other metallic components on the scanner’s

back panel. Immediately remove any moisture that contacts these components by
wiping them with a dry cloth.

• Do not use a sodden cloth or apply a liquid directly to any portion of the scanner.
Any moisture that enters the interior, the underside of the document glass or the
sensors may degrade image quality and lead to malfunctions.

• Never use substances containing alcohol, thinners or benzene on the equipment.
Use of these substances may deform, discolor or dissolve the casing.

Outer Casing

Document Glass

Document Cover

Never use substances
containing alcohol,
thinners or benzene to
clean the equipment.

• Do not press heavily on the document glass when cleaning. The
document glass may break and injure you.
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Guide to the Software
This section introduces to the software programs bundled with the scanner. For detailed instructions of
each program, please read the respective PDF manuals contained in the CD-ROM.
The screen shots in this manual are taken from the Windows platform, unless otherwise noted.

Guide to the Software

ScanGear CS-U .......................................................................... 11

ScanGear Toolbox .................................................................... 13

ArcSoft PhotoStudio ................................................................ 15

ArcSoft PhotoBase ................................................................... 16

ScanSoft OmniPage.................................................................. 17

Precautions for Scanning at High Resolutions............................................ 18
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ScanGear CS-U

ScanGear CS-U is the specialized driver software that allows you to scan and load images from the
scanner. It cannot be used as a stand-alone program. And must be started within an application
program.

Simple Mode
All you need to do is selecting the Image Type to scan immediately at the optimal settings.

Image Type

Toolbar
Adjust images easily with the
zoom, rotate and auto crop
buttons, etc.

Preview Button
Previews items and displays the
results in the preview area.

Preview Area
Displays the preview image. Use it
to select a scan area or adjust the
image.

Multi Photo Mode
Scans several photos at once and
opens individually in the
application window.

Simple Mode/Advanced Mode Switching Button

Advanced Mode
Set the Color Mode and Output Resolution to scan. Image brightness, contrast and color
balance can be fine-tuned.

• For details, please refer to the ScanGear CS-U User’s Guide (electronic
manual).
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ScanGear CS-U Features
• Scan with the optimal settings just by selecting the Image Type to suit your purposes in the

Simple Mode
• Adjust various settings, such as the color mode, resolution, color balance and brightness, in

the Advanced Mode
• Initiate various functions with the single press of a toolbar button
• See the image clearly in the large, easy-to-see preview area

Starting ScanGear CS-U
Select ScanGear CS-U as a TWAIN driver (Windows) or plug-in (Macintosh) from PhotoStudio,
PhotoBase or other compliant application programs. Please refer to each program’s manual
for the correct procedure since it varies between programs.

• ScanGear CS-U is not a stand-alone program that can be started by itself. It is used as a TWAIN
driver (Windows) or plug-in (Macintosh). Start the application program first, then start ScanGear
CS-U from the program. The images scanned while both programs are running will be directly
loaded into the application program.

Windows

Macintosh

The plug-in operates in the application program
window.

Start the TWAIN driver from the
application program.

Start the plug-in from the
application program.

ScanGear CS-U works as a TWAIN driver on top of the
application program’s window.
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ScanGear Toolbox

ScanGear Toolbox is a convenient program used to scan images, copy (print), attach images to e-mail
messages, or save images in a few simple steps.

ScanGear Toolbox Toolbar

• The OCR and Scan 1-2 buttons are automatically set to OmniPage, PhotoBase
and PhotoStudio respectively, if all the application programs are installed
from the CanoScan Setup Utility CD-ROM.

• To use the copy (print) function, the printer must be connected and on-line
and its printer driver must be installed on the computer.

• To use the e-mail function, a MAPI-compliant (Messaging Application Pro-
gramming Interface) program, such as Microsoft Outlook, Microsoft Outlook
Express or Eudora, must be installed and enabled. (for Windows)

How to Use ScanGear Toolbox
Starting ScanGear Toolbox

Windows
• Click the [Start] button on the Windows taskbar and select [Programs], [Canon ScanGear

Toolbox 3.0] and [ScanGear Toolbox 3.0].
Macintosh
• Open the [ScanGear Toolbox] folder and double-click the [ScanGear Toolbox] icon.

Copy Button
Scans an image and sends it to a printer.

Mail Button
Scans an image and attaches it to an e-mail.

OCR Button
Scans newspaper, magazine or book content,
for converting into text for a word processor.

Save Button
Scans and saves images.

Scan (1-3) Buttons
Scans images and sends to a linked application program.

Settings Button
For setting the scanner preferences.
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How to Use the Funtions

• Example: Copy (Print)
1. Click the [Copy] button.

2. The Scan settings dialog appears. Make settings as required.

3. Click the [Copy] button.

4. The image will be scanned according to the settings, and the image will be printed.

• For further settings and details, please refer to the ScanGear Toolbox User’s
Guide (electronic manual).

Image type
Select an image type from the menu. If you
select [Color(Autocrop)], the photo is
automatically cropped.

Image quality
Select a scanning resolution from [Draft],
[Good], [High] and [Super High].

Paper size
Select a size of the document you will scan.
If you select [Custom], the Paper size
setting window will appear to input the
accurate document size.
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ArcSoft PhotoStudio

PhotoStudio is an image editing program that can be used to load images from scanners and digital
cameras and process them with editing, retouching tools, special effects and enhancements.

Starting PhotoStudio and the Driver Software
Windows
1. Click the Windows [Start] button and select [Programs], [ArcSoft PhotoStudio 2000] and

[PhotoStudio 2000]. PhotoStudio will start.
2. Click  (Acquire icon) on the toolbar, or click the [File] menu and select [Acquire].

ScanGear CS-U will start and display its main window.

• If other TWAIN driver is installed on your computer, you must choose this
scanner before proceeding to Step 2. Click the [File] menu and select [Select
Source], and select [CanoScan N670U/N676U] or [CanoScan N1240U] on the
dialog box.

Macintosh
1. Open the [ArcSoft PhotoStudio] folder and double-click the [PhotoStudio™] icon.

PhotoStudio will start.
2. Open the [File] menu and select [Acquire] and [ScanGear CS-U 6.2.0...]. ScanGear CS-U will

start and display its control panel.

• For details, please refer to the ArcSoft PhotoStudio User’s Guide (electronic
manual).

Scan
Stitch

Apply
Special
Effects
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ArcSoft PhotoBase

PhotoBase is an image database program that can create and edit image albums, perform image
searches and create slide shows. It also handles sound and video files. The Windows version can
prepare images for pasting into web sites or send images as attachments for email.

Starting ArcSoft PhotoBase and the Driver Software
Windows
1. Click the Windows [Start] button and select [Programs], [ArcSoft PhotoBase] and

[PhotoBase]. PhotoBase will start.
2. Click  (Aquire icon) on the toolbar, or click the [Edit] menu and select [Acquire]. In the

Select Source dialog, select [CanoScan N670U/N676U] or [CanoScan N1240U]. ScanGear
CS-U will start and display its main window.

Macintosh
1. Open the [ArcSoft PhotoBase] folder and double-click the [ArcSoft PhotoBase] icon.

PhotoBase will start.
2. Open the [File] menu and select [Import] and [ScanGear CS-U 6.2.0...]. ScanGear CS-U will

start and display its control panel.

• For details, please refer to the ArcSoft PhotoBase User’s Guide (electronic
manual).

Create Albums
Paste Images into Web Pages
(Windows)
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ScanSoft OmniPage

ScanSoft OmniPage Pro (Windows) / SE (Macintosh)  is an optical character recognition (OCR) program
that converts characters scanned from a book, magazine or newspaper into text data for editing or
digital transmission. After conversion, the text can be edited with word processors and similar
programs.

Starting OmniPage and the Driver Software
Windows
When you install OmniPage Pro, the Add Scanner Wizard will display. Choose the [CanoScan
N670U/N676U] or [CanoScan N1240U] option. This instructs OmniPage Pro to select the correct
scanner for scanning.
1. Click the Windows [Start] button and select [Programs], [Caere Applications] and

[OmniPage Pro 9.0]. OmniPage Pro will start.
2. Click the [Scan Image] button on the toolbar, or open the [Process] menu and select [Scan

Image]. The scanner will start scanning and display the scanned image in OmniPage Pro.

• If the toolbar button displays as [Load Image], click the arrow and select [Scan
Image]. Or if the Process menu item displays as [Load Image], open the [Process]
menu and select [Process Settings]. In the [Process] tab, select [Scan Image].

Macintosh
1. Open the [OmniPage 8 SE Folder] folder and double-click the [OmniPage 8 SE] icon.

OmniPage SE will start.
• For the initial setting, open the [Settings] menu and select [Select Scanner], then

select [CanoScan N670U/N676U] or [CanoScan N1240U].

2. Click the [Scan Image] button on the toolbar, or open the  [Process] menu and select [Scan
Image]. ScanGear CS-U will start and display its control panel.

3. Select [Black & White] in the [Color Mode], and 300 dpi or higher resolution. Click the [Scan]
button. The scanned image will display in OmniPage SE.

• If the toolbar button displays as [Load Image], select [Scan Image] from the
button below it. Or if the Process menu item is labeled [Load Image], open the
[Process] menu and select [Process Settings] and [Scan Image].

• For details, please refer to the ScanSoft OmniPage Pro/SE User’s Guide
(electronic manual).

MacintoshWindows
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Precautions for Scanning at High Resolutions

Please note that file sizes increase almost exponentially as the resolution is raised when scanning in
color mode. Scanning at high resolutions may require more time for scanning and image processing.
You are recommended to avoid raising the resolution beyond the minimum requirement to scan in
color mode.

File Size Estimates for Scanning an A4 Size Original in Color
- 75 dpi 1.6 MB
- 100 dpi 2.8 MB
- 150 dpi 6.3 MB
- 300 dpi 25.5 MB
- 600 dpi 102 MB
- 1200 dpi 408 MB

* These numbers are approximate and may differ from actual scan results.

Resolution Guidelines
• For uploading to a web site or viewing on a computer monitor, choose 75 dpi
• For scanning print photos and magazine clippings, choose 150 - 300 dpi
• For printing on a inkjet printer, choose a resolution approximately half the printer’s rating (180 dpi,

360 dpi, 600 dpi or 720 dpi)

A resolution higher than 600 dpi is effective in case for scanning relatively small originals that will be
blown up to larger sizes for printing.

Scanning at double 
of the resolution

Scanning at half 
of the resolution

12"(30cm)

3"(7.5cm)

2"(5cm)

6"(15cm)

4"(10cm)

8"(20cm)

The maximum file sizes scanned by the bundled PhotoStudio and PhotoBase are limited by Windows
Me and Windows 98 to 256 MB. Windows 2000 Professional does not impose these limits.

2.8 MB

100 dpi

1.6 MB

75 dpi

6.3 MB

150 dpi

408 MB

1200 dpi

102 MB

600 dpi

25.5 MB

300 dpi

A4 color image
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Customer Support Help Desk
CANON INC.

30-2, Shimomaruko 3-chome, Ohta-ku
Tokyo 146-8501, Japan

CANON U.S.A., INC.
Digital Home and Personal Systems Division

2995 Redhill Avenue
Costa Mesa, CA 92626, U.S.A.
1-800 OK CANON

http://www.ccsi.canon.com

CANON CANADA INC.
6390 Dixie Road, Mississauga
Ontario L5T 1P7, Canada
1-800 OK CANON

http://www.canon.ca

CANON LATIN AMERICA, INC.
6505 Blue Lagoon Drive, Suite 325
Miami, Florida 33126, U.S.A.

CANON MEXICANA, S. de R.L. de C.V.
Anillo Periferico Sur No. 4124, Torre Zafiro (II) Colonia
Ex-Rancho de Anzaldo, Piso 5 y 6, Mexico D.F.

Tel. (525) 5490-2000

CANON PANAMA, S.A.
Apartado 7022, Panama 5
Rep. de Panama

Tel. (507) 279-8900

CANON CHILE, S.A.
Ave.  Manquehue Norte #1337, Piso 3, Casilla 187-9,
Santiago, Chile

Tel. (562) 366-6600

CANON ARGENTINA, S.A.
Ave. Corrientes 420 (1043)
Buenos Aires, Argentina

Tel. (5411) 432-59800

CANON EUROPA N.V.
P.O. Box 2262 1180 EG Amstelveen,
The Netherlands

CANON (UK) LTD.
Woodhatch, Reigate
Surrey RH2 8BF, United Kingdom
For technical support, please contact Canon Helpdesk.
Helpdesk:

P.O. Box 431, Wallington, Surrey SM6 0XU
TEL: (08705) 143 723
FAX: (08705) 143 340
For sales enquiries: (0121) 666-6262

CANON FRANCE S.A.
17, quai du Président Paul-Doumer
92414 Courbevoie Cedex, France

Tél.01 4199 7777  Fax.01 4199 7951
Hotline: Tél.01 4199 7070

CANON DEUTSCHLAND GmbH
Postfach 528, 47705 Krefeld, Germany
CANON- Hotline-Service

Customer Support: (0 21 51) 349-555
Info-Desk: (0 21 51) 349-566
Mailbox: (0 21 51) 349-577
Telefax: (0 21 51) 349-588

CANON ITALIA S.p.A
Palazzo L, Strada 6,
20089 Milanofiori-Rozzano (MI), Italy

TEL: 02/8248. 1  FAX: 02/8248. 4604
Pronto Canon 02/8249. 2000
http://www.canon.it

CANON BENELUX NEDERLAND N.V.
Neptunusstraat 1, 2132 JA Hoofddorp
The Netherlands

Tel: 023-5 670 123  Fax: 023-5 670 124
Helpdesk: 023-5 681 681

CANON BENELUX BELGIUM N.V./S.A.
Bessenveldstraat 7, 1831 Diegem, Belgium

Tel: 02 7220411  Fax: 02 7213274
Helpdesk: 02 7220404

CANON GmbH
Zetschegasse 11, 1232 Wien, Austria

CANON (SCHWEIZ) A.G.
Industriestrasse 12, CH-8305 Dietlikon
Switzerland

Tel: (01) 835 61 61  Fax: (01) 835 68 60
Hotline: 157 30 20

CANON ESPAÑA S.A.
C/Joaquin Costa No 41, 28002
Madrid, Spain

Help Desk: 906.301255
Tel.: 91-5384500  Fax.: 91-4117780

CANON DANMARK
Vasekær 12, DK-2730 Herlev, Denmark

Hotline: 44 88 26 66
http://www.canon.dk

CANON NORGE AS
Hallagerbakken 110, Boks 33, Holmlia, 1210 Oslo 12, Norway

Tlf: 2262 9321  FAX. 2262 0615

CANON SVENSKA AB
Gustav III:s Boulevard 26, S-169 88 Solna, Sweden

Tel 08-744 85 00
Fax 08-744 64 65
http://www.canon.se

CANON OY AB
Kornetintie, 3, 00380 Helsinki, Finland

Puhelin: 010 544 20
Helpdesk: 0600-0-22606

(maksu 14,80 mk/min)
Fax: 010 544 4571

CANON SINGAPORE PTE. LTD.
79 Anson Road #09-01/06
Singapore 079906

http://www.canon-asia.com

CANON MARKETING SERVICES PTE. LTD.
No. 1, Jalan Kilang Timor
#09-00 Pacific Tech Centre
Singapore 159303

Tel:  65-7998888, Fax:  65-2736786,
Hotline:  65-3342726

http://www.canon.com.sg

CANON MARKETING (MALAYSIA) SDN. BHD.
Block D, Peremba Square
Saujana Resort, Section U2, 40150 Shah Alam
Selangor Darul Ehsan, Malaysia

Tel:  603-7446000, Fax: 603-7446048,
Helpdesk:  603-7446008/9

Enquiry:  print&scan@canon.com.my
http://www.canon.com.my

CANON MARKETING (THAILAND) CO. LTD.
179/34-45 Bangkok City Tower, 9th-10th Floor
South Sathorn Road, Thungmahamek,
Sathorn, Bangkok 10120, Thailand

Tel:  662-3449999, Fax:  662-3449968
http://www.canon.co.th

CANON MARKETING (PHILIPPINES) INC.
Marvin Plaza Building, 2153 Don Chino Roces Ave,
Makati City, Metro Manila, Philippines

Tel:  632-8126047, Fax:  632-8120067/8109797

CANON INDIA PVT LTD.
Neela Gagan, Mandi Road,
Mehrauli, New Delhi-110030, India

Tel:  91-11-6806572, Fax:  91-11-6807180

CANON HONGKONG CO., LTD.
9/F, The Hong Kong Club Building
3A Chater Road, Central, Hong Kong

TEL:  (852) 2739 0802
FAX: (852) 2739 6428

CANON AUSTRALIA PTY. LTD.
1 Thomas Holt Drive, North Ryde, Sydney N.S.W. 2113, Australia

Info-Line: (02) 9805 2864

CANON NEW ZEALAND LTD.
Fred Thomas Drive, Takapuna
P.O. Box 33-336, Auckland, New Zealand

Info-Line: 0900-522666

ADOBE SYSTEMS INCORPORATED
http://www.adobe.com

ARCSOFT, INC.
http://www.arcsoft.com

SCANSOFT, INC.
http://www.scansoft.com

I-OE-063A 012001CDS © CANON INC. 2001
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